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Uzaktan Kontrol Nasl Yaplr ?

Uzaktan Kontrol Yazlm yada Remote Administration kullanmak
istediiniz bilgisayarn yanndaolmadan bilgisayar tam anlamyla
kullanmanz salayan yazlmlardr. Gnmzde bir ok amalakullanlan uzaktan
kontrol yazlmlarnn piyasada bir ok rnei bulunmaktadr. 10 yldan
fazla birzamandr bu pazarda rn bulunduran Symantec gurubunun
pcAnyware yazlmnn yannda Famatec'in

Remote Administrator program ayrca GoToMyPC veya LogMeIn ve daha
fazlas tabiki Microsoft.

Burada sadece yazlmlarn kurulumlarndan bahsetmeyeceiz nk burada
sz edilen bir okprogram sadece programlarn kurulmas ile grevlerini
yapamazlar. Ayrca bu tr programlarn devamlkullanlmayacan da gz nnde
bulundurursak programlarn bilgisayarnza getirdii ekstra yknemlidir.
Ylda 3-5 defa iinizi grecek bir programn sistem kaynaklarn devaml
olarakkullanmas hide mantkl deildir.

Tam burada sistem kaynaklarndan bahserken yularda listelediimiz
programlardan en baarlsFamatec'in Remote Administrator yazlm yada
ksaca Radmin dir. Programn hem Sunucu hemdeynetim ksm son derece az
sistem kaynana ihtiya duymaktadr. Bu konuda Logmein PcAnywareve
GotoMyPC pek de iyi kaynak kullandklar sylenemez.

Ancak Mesela Logmein programnn bir avantaj ise herhangi bir
ekilde bilgisayar, firewall,modem veya router cihazlarnda herhangi
bir port ynlendirmesine gerek duymamasdr. Ayrcauzak bilgisayarda
olan bir belgeyi sadece bir ka tklamayla kendi bilgisayarnza
balyazcdan kt alabilirsiniz.

Tm bunlarn yannda PcAnyware ve Radmin dier programlara gre bir
ok avantaj iermektedir.iki programdada dosya transfer modl ile
normal artlardan daha hzl dosya transferigerekletirebilirsiniz.
Bunun iin tam ynetim modunuda kullanmanza gerek olmadndangereksizce
veri transferi yaplmasnnda nne geilmitir.Tm bunlarn yannda
PcAnyware ve Radmin ulamak istediiniz bilgisayarn IP adresi sabit
deilise size bunun iin nlem almanz gerekli aksi takdirde ulamanz
mmkn olmayacakr. Yada eniyi artlarda biraz uraacaksnz. Bu tabi
Local bir a iin geerli aksi takdirde internetzerinde tm
bilgisayarlar taramanz baya zamannz alacaktr.

Bu amala bilgisayarnz yada modeminize Dinamik DNS servislerinden
alacanz kullanc ad veifrenizi girmeniz her daim bilgisayrnza
ulamanz salayacaktr. Bu servisler iin Bir okmodem ve router
www.dyndns.org , www.no-ip.org , ve www.tzo.com gibi servis
salayclardesteklemektedir. Bunun iin ilgili cihaznzn reticisine
veya kullanm kitapninceleyebileceiniz gibi direkt olarak modem
ayarlarndan da bilgi edinebilirsiniz. Buarada yazmzda getii zere
kontrol etmek istediiniz bilgisayarn IP adresini
bilmenizgerektiinden bahsettik ama GoToMyPC ve LogMeIn
programlarnda buna gerek yok buprogramlar bilgisayarnza
yklediinizde yklenen program gereki kullanc ad ve
ifreyikaydettiiniz srece kendi Sunucusuna gerekli IP bilgilerini
ulatracaktr.

imdi ise IP adresinin yannda gerekli olan bir bilgi daha var
buda PORT adresi; Portsanal olarak oluturulmu bir yntemdir. her IP
adresi iin 65536 adet port tanmlanmtr. buportlardan her birisi baka
bir ilem iin kullanlabilir. Veya ayn port iki ilem
iindekullanlabilir fakat bu ayn olmas durumunda karklklar olacaktr.
Ve amacnzaulaamayacaksnz. rnek olarak internette gezinirken
kullandmz tarayclar 80 nolu portu,sunucular 21 nolu portu kullanr.
Bu listeye baz zararl yazlmlarnda kullandn ve buyazlmlardan dolay
Firewall yazlmlar ile bu tr yabanc yada zararl girilerden
korunduumuzuda belirtelim. Bu tr yazlmlarn bir ounda portlar
istediimiz ekilde ayarlayabilmekteyiz.Genel bilgiverdikten sonra
imdi bir ok stn zelliinden dolay Remote Adminsitrator yazlmnnasl
kurup nasl kullanacanz aada bulabileceksiniz.

ncelikle Remote Administrator Programn : www.famatech.com
adresinden indirerek ie

balayabilirsiniz. Baz Antivirs yazlmlar bu sitenin gvenilmez
yada tehlikeli olaraknitelendirere siteyi amayabilir. Buraya
tklayarak indirebilirsiniz.Kurulum Ynergesi
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Yazlm Kurulumu :

- Kurulumu balatn.- Next 'e basarak Lisans Szlemesi ekranna
gein.- Lisan szlemesini kabul ediyorsanz ilgili kutucuu
iaretleyerek Next butonuna basn.- Dikkat edilmesi gereken notlar
okuduktan sonra Next butonu ile devam edin. Notlarla

ilgi sorun yaayacaksanz bu durumu dzelttikten sonra bu ynergeyi
uygulayn.- Kurulumunu yapmak istediiniz program sein. Viewer
program ynetim yazlmdr. Server iseynetilecek PC de olmas gereken
yazlmdr. her iki yazlm yklenmesinde herhangi bir sorunolmaz. Next
Botunu ile devam edin.- Programn Kurulaca Dizini sein. Start butonu
ile kurulumu balatn.- Kurulum bittikten sonra Eer Server programn
yklemiseniz sizden bireriim ifresiisteyecektir. Bu ifreyi
bilgisayarnza ulamasn istediiniz kimseye vermeniz
gerekmektedir.

Aksi takdirde kesinlikle eriemez.- ifreniziiki defa giriniz (en
az 8 kaarakter) bilgisayrnz yeniden balatmak isteyipistemediiniz
soracaktr. Hayr butonuna basn.- Balat Mensnde oluturulan
ksayollardan "Settings for Remote Administrator server" aift
tklayarak an.

- Burada ifrenizi deitirebilir, Balangta ykleme ayarn
deitirebilir ve Seenekler mensnegirip balanacak bilgisayarlar iin
ayarlamalarnz yapabilirsiniz.Burada dikkat etmenizgereken Yerel bir
ada tm bilgisayrlarda ayn portu kullanmanz durumunda devaml
olaraksadece bir bilgisayra ulaabilrsiniz. Bunun iin port
adreslerini kendi belirleyeceinizbir aralkta tutmanz faydal
olabilir. (Varsaylan PORT 4899'dur)- Balat Mensnde oluturulan
ksayollardan "Start Remote Administrator server" a ifttklayarak
balattktan sonra Saatin yannda Mavi R semboln grdnzde programn
kurulumtamamdr.- Bu ynergeyi kurmak istediiniz tm bilgisayrlara
uygulayn. Yerel ada alacak isenizDNS server a her bilgisayarn tanmn
yaparak her bilgisayarn IP adresini rezerve edin. Eer DNSsunucunuz
yoksa her bilgisayarda sabit IP kullanmasn ayarlamanz
gerekecektir.

nemli Not : Yukarda yaplan ilemleri birden ok bilgisayarda
yapacak iseniz Her IP adresiiin verdiiniz PORT numarasn ve tabiki
IFRElerin mutlaka notlarn aln. Erimesiniisteyeceiniz kimselere bu
bilgileri vermelisiniz.

Eriim Cihaz Kurulumu :Bu ynerge internete eriimde kullandnz
modem, router vb. cihazlara gre deiecektir. Busebeple burada sadece
yaplmas gereken ilemleri yazacaz. (USB modem veya Normal(evirmelia
kullanan) kullanan kullanclardan bu ayarlar gerek yoktur.Modem
ayarlar nasl yaplr ? Port ynlendirme nasl yaplr ?

- ilgili cihaznn ayarlar sayfasna ynetici olarak giri yapn.-
Cihazn destekliyor ise tm bilgisayarlar DNS Server ksmnda
tanmlayarak IP adreslerinirezerve edin. ( bu sayade her bilgisayar
devaml olarak ayn IP'yi alacaktr)- Daha sonra "Virtual Server"
sekmesine geerek tanmladnz IP adresindeki bilgisayrn PORT

numaras ile birlikte buraya kaydedin. (ayn port adreseini
vermeniz durumundabalantlardan sadece birisi alacaktr.)- Cihaznza
ayarlar kaydedin. Cihaz kapayp an ve ayarlarn kaytolduundan emin
olun.

nemli Not : Yukarda yaplan ilemler sadece internet zerinden yada
yerel adaki ynetimbilgisayarlarnn farkl bir datcya bal ise gerek
vardr.

Antivirs/Firewall Kurulumu :Bu ynerge yine kullandnz Antivirs,
Internet Security veya Firewall yazlmna gredeiecektir. Bu sebeple
burada sadece yaplmas gereken ilemleri yazacaz.

- ilgili yazlmnzdaki Firewall ayarlarn an.

- Bu firewall ayarlarn deitirmek iin varsa kullanlan profil
ayarlarna giri yapn.- Genelde "Exceptions" olarak grntlenen Izin
verilenler ksmna gein.- Buraya yeni kural eklemek iin EKLE butonuna
basn.
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- Protocol ksmna TCP- Iletiim Yn olarak gelen (incoming)
seemeniz yeterli olabilir. Fakat baz firewalllariin iki ynl olarak
ayarlanmas gerekebilir.- PORT ksmna ilgi bilgisayara atadnz port
(Varsaylan 4899'dur)

Windows Firewall Kurulumu :

- Windows firewall Ak konuma getirin. (Baka bir Antivirs yad
firewall kullanyorsanzkapal durumda kalmaldr)- zel Durumlar
sekmesine gein.- Balant Noktas Ekle butonuna basn.- Ad ksmna Radmin
yada istediiniz ismi verin.- Ba.Nok.No : ksmna ise bilgisayarda
ayarladnz PORT numarasn yazn.(Varsaylan 4899)- TCP Protokoln
deitirmeyin.- Eer bilgisayarnza sadece a zerinden eriimini
ayarlamak istiyorsanz Kapsam deitirbutonuna basarak size uygun
seenei seiniz.- Tamam butonu ile Ayarlarn listeye eklendiini
grdnzde ayarlarnz yaplm demektir.

Bu ayarlar kullanmak istediiniz tm bilgisayrlarda uygun ekilde
ayarlayarak UzaktanKontrol kullanabilirsiniz.
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Getting Started

This guide shows you how to set up your PC with GoToMyPC and
access it from another

computer. It also explains the main features of GoToMyPC so that
you can begin workingquickly.

System Requirements

Host PC

y Microsoft Windows 2000 or newer

y Internet Explorer 5.0 or newer; Firefox 1.0 or later or
Netscape 7.0 or newer

y "Always on" Internet connection (cable, ISDN, DSL or
better)

Client Computer: Viewer for Windows - Full Features

y Microsoft Windows 95 or newer

y Recommended: Microsoft Windows 2000 or newer

y Internet Explorer 5.0 or newer; Firefox 1.0 or newer or
Netscape 7.0 or newer

y Recommended: The connection process is easier if Java is
installed and the Webbrowser supports Java

Client Computer: Universal Viewer for Windows - Limited
Features

y Microsoft Windows with Internet Explorer 5.0 or newer, Firefox
1.0 or newer or Netscape

7.0 or newer; and Microsoft Java or Sun Java

y Recommended: The Sun Java 2 Standard Edition (J2SE) version
1.4 or newer

Client Computer: Universal Viewer for Mac - Limited Features

y Mac OS X with Safari 1.0 or newer or Firefox 1.0 or newer; and
Sun Java

Client Computer: Universal Viewer for Linux and Solaris -
Limited Features

y Firefox 1.0 or newer or Netscape 7.0 or newer; and Sun
Java

Client Computer: Universal Viewer on other platforms - Limited
Features

y Other operating systems and browsers that support Java and
have a full Java 2 Standard

Edition JVM should work but have not been tested

Client Computer: PocketView for Windows CE - Limited
Features

y Microsoft Windows Mobile 6.0 Classic and Pro

y Microsoft Windows Mobile 5.0 for Pocket PC or Pocket PC Phone
Edition

y Microsoft Windows Mobile 2003 or 2003 SE for Pocket PC or
Pocket PC Phone Edition

y Most devices running Microsoft Windows CE 4.0 or later with a
touch screen or mouse

(such as thin clients)

y Internet Explorer, Pocket Internet Explorer, or equivalent web
browser

Note: Windows Mobile versions that lack a touchscreen are not
supported. This includes Windows Mobile 6.0 Standard,5.0 for
Smartphones and 2003 / 2003 SE for Smartphones.
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Feature Requirements

Host95, 98

and MENT 4.0 2000 XP (32) XP (64)

Server

2003 (32)

Server

2003 (64)

Vista

(32)

Vista

(64)

Screen Sharing v5.0 v5.0 9 9 9 9 9 9 9

Multi-Monitor Support v5.0 v5.0 9 9 9 9 9 9 9

Desktop Shortcut v5.0 v5.0 9 9 9 9 9 9 9

File Transfer v5.0 v5.0 9 9 9 9 9 9 9

File S ync 9 9 9 9 9 9 9

Drag and Drop 9 9 9 9 9 9 9

Native Printing v5.0 v5.0 9 9 9 9 9 9 9

GoToMyPC Printer 9 9 9 9 9 9 9

Sound 9 9 9 9 9 v6.1 v6.1

Bro w s e r Re q u ire m e n t s : Internet Explorer 5.0 or
newer Netscape 7.0 or newer Firefox 1.0 or newer

Not supported

v.5.0 Supported in v5.0 but not v6.0

9 Supported

9 New in v6.0

Client95, 98

and MENT 4.0 2000 XP (32) XP (64)

Server

2003 (32)

Server

2003 (64)

Vista

(32)

Vista

(64)

Screen Sharing 9 9 9 9 9 9 9 9 9

Multi-Monitor Support 9 9 9 9 9 9 9 9 9

Desktop Shortcut 9 9 9 9 9 9 9 9 9

File Transfer 9 9 9 9 9 9 9 9 9

File Sync 9 9 9 9 9 9 9 9 9

Drag and Drop 9 9 9 9 9 9 9

Native Printing 9 9 9 9 9 9 9 9 9

GoToMyPC Printer 9 9 9 9 9 9 9

Sound 9 9 9 9 9 9 9 9 9

Brow ser Requirements : Internet Explorer 5.0 or newer Netscape
7.0 or newer Firefox 1.0 or newer

Mobile

5.0-6.0Mobile

2003 / SECE 4.0 &

newer

Screen Sharing 9 9 9

Multi-Monitor Support 9 9 9

Desktop Shortcut 9 9 9

File Transfer

File Sync

Drag and DropNative Printing

GoToMyPC Printer

Sound

Windows Mobile versions that lack a touchscreen

are not supported Windows CE 4.0 or newer with a touch screen
or

mouse, suc as t n c ent evces are supporte

Windows

PocketViewUniversal Viewer

Mac

8.6+

Mac

10.3.9

Mac

OS XLinux Solaris

Screen Sharing 9 9 9 9 9

Multi-Monitor Support 9 9 9 9 9

Desktop Shortcut 9 9 9 9 9

File Transfer

File Sync

Drag and Drop

Native PrintingGoToMyPC Printer

Sound

Sun J ava 1.4 Standard Java Virtual Machine Recommended

* Untested but should work with the proper JVM

Brow ser Requirements: Sun J ava 1.1 Standard Java Virtual
Machin

Internet Explorer 5.0 or newer Netscape 7.0 or newer

Firefox 2.0 or newer Safari 1.1 or newer

** Linux testing included Ubuntu, SUSE and Knoppix


	
7/29/2019 Remote Control.pdf

14/96

GoToMyPC User Guide

2008 Citrix Online, LLC. All rights reserved. 3

Notes on I nstallation and Feature Access

Please keep the following information in mind when installing
and using GoToMyPC:

y Because of various operating system restrictions, GoToMyPC
requires the service to be

installed on the host PC with administrator rights enabled.
Please see your administrator

for assistance.

y Because of various operating system restrictions and hardware
requirements, somefeatures of GoToMyPC may not function on some
computers. Please see the FeatureRequirements section for details.
For Server 2003 as a host PC, the www.gotomypc.com

Web site must first be added as a trusted site.

y If you are GoToMyPC Corporate or Pro user, your administrator
has the ability to restrictaccess to features and/or to require the
use of some features. If you have questions

about your feature-access rights, please see your administrator
for assistance.

Versions of GoToMyPC

There are three versions of GoToMyPC.

y GoToMyPC Secure remote access for individual users

y GoToMyPC Pro Secure remote access for teams and small
companies

y GoToMyPC Corporate Secure remote access for small and
medium-sized businesses
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Useful GoToMyPC Terms

Access Code - The access code is the unique password that users
set up for each host PC. It

must contain at least eight characters and include both letters
and numbers. Users will

enter their access codes every time they access their host PCs
remotely.

Account Password - The account password is used to log in to the
GoToMyPC Web site. Itmust be at least eight characters and contain
both letters and numbers.

Client Computer - The client computer is the computer used to
access the host PC. It can

be any Internet-connected computer with a Windows or
Java-enabled browser,

located anywhere in the world (airport kiosk, Internet cafe,
hotel, library, etc.).

Computer Nickname - The computer nickname is the name assigned
to a host PC duringinstallation of the GoToMyPC software. Nicknames
help identify different computers set

up for remote access.

Host PC - The host PC is the computer you will want to access
from a remote location. Youwill install the GoToMyPC software on
the host PC. The host PC is a unique and specific

computer.

Host PC image - The host PC image is the picture of the host PC
desktop that appears in the

Viewer window.

One-Time Passwords One-Time Passwords offer an additional level
of security for users.This feature will help defeat
keyboard-sniffer or keystroke-logger software.

RADIUS - RADIUS is a two-factor authentication method based on
something you know (a

password or PIN) and something you have (an authenticator),
providing a more robustlevel of user authentication. RADIUS is
available on GoToMyPC Corporate.

Session A session refers to the time you are remotely connected
to your host PC.

System tray icon The system tray icon represents the status of
the GoToMyPC serviceand is used to access GoToMyPC preference and
setting options. To access system

preferences, right click the system tray icon and select
Preferences.

Status state representations

Icon Status

GoToMyPC host PC is running and ready for use

GoToMyPC host PC requires authorization before use may begin

GoToMyPC host PC is running but connection is interrupted

GoToMyPC host PC is being accessed in a session

GoToMyPC host PC has screen-blanking enabled while in a
session

Viewer - The Viewer is the window displayed on the client
computer in which the host PCs

desktop will appear. The Viewer window has its own title and
menus.

Windows Name The Windows name can be used along with the
computer nickname toidentify your computers.
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Features

Automatic Setup: Plug-in automatically launches, installs and
configures itself. No

restart required. Even novice users can be ready to go in
minutes.

Universal Viewer: When you connect to your PC, the Viewer window
launchesautomatically, allowing you to view and control your PC
from another Windows,

Windows CE, Mac, Linux, Unix or Solaris computer. No pre-loaded
software required.Access your PC from any Web browser on any
operating system at any time. Evenwork on your office Windows PC
from your Mac at home.

PocketView Wireless Access: Securely access your PC from your
wireless PocketPC device running Windows Mobile 2003/2003SE or
later from your device running

Windows CE 4.0 or later. Provides ultimate mobility.

Drag-and-Drop File Transfer: Easily transfer files by dragging
and dropping foldersand directories between computers. You never
again need to email files to yourself or

copy to a USB flash drive. Get access to your files at any time
from anywhere.

File Sync: Synchronize files and folders between your remote PC
and any other

computer with just a click.

Sound: Hear sound on your remote PC with customizable audio
settings. Automatic

muting on your remote PC means sound can only be heard by
you.

True Color: View your desktop in brilliant true color.

Performance Tuning: Adjust the speed, sound, color quality and
display settings to

get the performance that best suits your needs.

Multi-Monitor Support: Use GoToMyPC with multiple monitors
connected to a singlePC.

Guest Invite: Invite a second person to temporarily view or
share control of your PC.

Great for tech support, demos or conference viewing of
information.

Remote Printing: Print documents to any printer wherever you
happen to be

there's no need for the application that created the document to
be installed on the

client computer. A hard copy of that forgotten file is only a
connection away.

Cut and Paste: Cut, copy and paste text between computers.
Simplifies transfer of

content between desktops.

Encryption and Maximum Security: All data is protected with AES
encryption using128-bit keys. Dual passwords and end-to-end user
authentication. Option to use One-

Time Passwords for maximum security. Most secure Internet
connection available in a

remote-access product.
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Setting Up GoToMyPC

Before you can access your PC remotely, youll first need to
create your account (first time

users), install the GoToMyPC software and leave the PC
accessible. To do this, you will need tobe at the PC and have the
email address and password you used to register.

Note: To enable all features and functionality, GoToMyPC needs
to be installed with Administrator Rights, therefore,Corporate and
Pro users please contact your administrator for assistance; in some
instances, your administrator may

install GoToMyPC Corporate for you using a remote installation
process.

Create Your Account (first time users)

To create your account

1. Go to your email account and open the email titled Set Up
GoToMyPC.

2. Click the link in the email to activate your account (first
link in email). A new browser

window opens and prompts you to create your account.

3. Enter your first and last name, create and confirm your
account password, click Submit.

Set Up a Host PC

To set up a host PC for remote accessStep One - Download the
software

1. Be at the PC that you will want to access remotely; this will
be the host PC.

2. Open a browser window and go to www.gotomypc.com.

3. Enter your email address and account password and click the
Log In button.

4. First-time users, or users without any PCs set up, click the
Install GoToMyPC button.Returning users who have more than one
license can add additional host PCs from this

screen.

5. Click Yes or Grant from the Warning Securityscreen to begin
downloading the

GoToMyPC software.

Step Two - Install the software

1. Click Next to begin installation.

2. Select "Yes, I want to restart my computer now" if you intend
to use the Fast User

Switching feature during this session and click Finish.

Note: If you are using security or firewall software, you must
permanently allow GoToMyPC to connect to theInternet. See the Using
GoToMyPC with Firewalls section for more information.

Note: If you are a GoToMyPC Corporate user in an environment
that requires authentication to access theInternet, you will be
prompted to enter your authentication during setup. Please contact
your administrator forfurther details.

3. When prompted, enter your email address and account
password(these are the same

that you use to log in to the GoToMyPC Web site) and click
OK.

4. When prompted, enter a computer nickname for the host PC; if
needed, select the

account to which this computer should belong. Give the PC an
access code, confirm the

access code and click OK.

Note: If you forget your access code or wish to change it, you
can quickly create a new one from your host PC.Please see the
section titled Forgot Host PC Access Code for details.

Note: For the highest level of security we recommend that your
access code be different from your accountpassword.

5. The icon will appear in the system tray to let you know that
the service is running.

https://www.gotomypc.com/https://www.gotomypc.com/
	
7/29/2019 Remote Control.pdf

18/96

GoToMyPC User Guide

2008 Citrix Online, LLC. All rights reserved. 7

Leave Your Host PC Accessible

To be able to access your host PC from a remote client computer,
you need to ensure that your

host PC meets the three following conditions:

1. The host PC is turned on.

2. The host PC is connected to the Internet with a live
connection.

3. The GoToMyPC service is running.

Note: To help ensure security, you may want to lock your PC
before you leave it unattended.

Note: Since GoToMyPC does not require the display monitor on
your host PC, you may want to turn it offbefore you leave to
conserve energy. You can also set your monitor to automatically
power down after aspecified time in the Display Properties control
panel.

Accessing Your GoToMyPC Host PCOnce GoToMyPC is set up and
running on your host PC, you can access it immediately from

almost any other client computer with Windows or a Java-enabled
browser that is connected to

the Internet, such as from computers at airport kiosks, Internet
cafes, hotels, etc.

To remotely access your host PC, youll need to be at a client
computer (any computer other

than the host PC you just set up) and you will need to know your
email address, password and

access code.

Access Your Host P C

To remotely access your host PC

1. In your Web browser, type www.gotomypc.com.

2. Enter your Email address and account Password and click Log
In.

3. If prompted, choose the account you want to access and click
Go (only applies if youhave multiple accounts associated with one
email address).

This will load your My Computers page.4. To the right of the
Nickname of the PC to which you want to connect, click the
Connect

button.

5. If prompted, click Run to download the GoToMyPC Viewer.
PocketView users will need to

click the Download link to begin download.

6. When prompted, enter the Access Code for the host PC and
click OK.

7. The host PC image will appear in the Viewer window.

You are now connected to your host PC and are ready to start
accessing all your files,

applications and email as if you were sitting at your PC!

Note: If a PC's status is Offline, then you will not be able to
access that host PC. To access a host PC, you need to leavethe PC
on and connected to the Internet with GoToMyPC running.

Note: If you are a GoToMyPC Corporate user and your host is a
shared PC that is being accessed by another GoToMyPCuser, "In
Session" will appear in the connect box. If you choose to connect
to a PC while it is in session, the session inprogress will be
terminated. Keep in mind that the In Session notification will
display until the first user terminates theconnection with the host
PC and you refresh your browser.

https://www.gotomypc.com/https://www.gotomypc.com/
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Set Quick Searches

If your account has more than 10 PCs accessed by the same email
address, you can quicklylocate a favorite host PC with the Quick
Searches feature.

To set a Quick Search

1. Select a Quick Searches number that you would like associated
with a common search.

2. In the Search field enter a host PC nickname; or portion of a
nickname if you use the *wildcard option.

3. Click the Set Quick Search button to save the search for
future use.

4. The next time you wish to initiate a saved search from the
Computer List, simply select

the Quick Searches number to view your host PC(s).

Note: This feature is limited to 5 saved searches but a number
can be reassigned at anytime.
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Remotely Unlock Your Host PC

If your host PC is locked, it may require additional action to
unlock it. Your operating system

determines the unlock method.

To unlock 2000, XP Professional or Vista use the Send
Ctrl-Alt-Del feature

1. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del;
or you can click the Send

Ctrl-Alt-Del button in the upper right-hand corner of the Viewer
window.

2. Unlock your PC as you normally would using your network ID
and Password.

To unlock XP Home (or XP Professional with Fast User
Switching)

1. If the screensaver is running, move the mouse to deactivate
it.

2. This displays the logon screen.

3. Log in to your PC as you normally would.
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Remotely Lock Y our Host P C

When you are through using your host PC, we recommend that you
lock your computer to helpprotect your data. You can set the
GoToMyPC Preferences to automatically lock upon disconnect.

If you wish to do so manually, your operating system will
dictate the method you will use to lock

your PC.

To lock Windows 2000, XP Professional and Vista1. Complete all
activities on your host PC.

2. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del.
Or click

the Send Ctrl-Alt-Del button in the upper right-hand corner of
the Viewer window.

This will bring up the Windows Securityscreen.

3. Click the Lock Computer button.

Your computer workstation is now locked.

To lock Windows XP Home (or XP Professional with Fast User
Switching)

1. Complete all activities on your host PC.

2. Click the Windows Start button.

3. Select Log Off.

4. Select Switch User.

Your computer workstation is now locked.

End Your GoToMyPC Connection

Prior to disconnecting from your host PC, you may want to first
lock your computer to helpensure your security. You can customize
GoToMyPC on the Security tab in the Preferences

window to automatically lock your host PC upon
disconnection.

Note: If you are listening to music from your host PC, be sure
to stop the music before disconnecting your session. Ifyou do not
stop the music on the host PC before disconnection, the music will
no longer be muted and could be heard byanyone close to your host
PC.

There are three ways to end your GoToMyPC connection.

To end your GoToMyPC connection

y From the Viewer menu, choose File, then Disconnect.

- Or -

y In the upper-right corner of the Viewer window, click the
button.

- Or -

y Right-click the system tray icon and select End Session.
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The GoToMyPC Viewer

Resize Your View er Window

You can choose to have the Viewer appear as a window on your
desktop or as a full-screenimage.

y In Window mode: The Viewer appears as a window on your desktop
just like any otherapplication. The Viewer menu and the Windows
controls in the upper-right corner of your

screen are always available and you can resize the Viewer window
just like any other

application window.

y In Full Screen mode: The Viewer expands to full screen and the
Viewer menu auto-hidesat the top of the screen. A tab with the same
color as your Viewer window is displayed at

the top of the screen; this tab enables access to the Viewer
menu when needed.

To start Full Screen mode

y From the Viewer window menu, select View, then Full
Screen.

This expands the Viewer window to Full Screen.

To end Full Screen mode

1. Move your mouse over the Viewer window tab at the top ofthe
screen.

The Viewer menu is displayed.

2. Select View, then Window.

This cancels the selection of Full Screen mode and returns you
to a resizable Viewer

window.

Resize Your Host PC I mage

You can choose to change the size of the image of your host
PCdesktop within the Viewer. You have the options of choosing
to

adjust your image size toActual Size, Scale to Fitor Zoom
To.

y Actual Size: Displays the actual image of the host PCdesktop
within the Viewer and may require you to scroll.

y Scale to Fit: Displays the image of the host PC desktopscaled
to fit the whole desktop image within the Viewer.

y Zoom To: Allows you to zoom the image to a setting you

choose. You can choose from several pre-set options orchoose a
custom option. This selection may require you to

scroll.

To resize your host PC image

y From the Viewer window menu, select View and then your

preferred image size:

y Actual Size

y Scale to Fit

y Zoom To
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Multi-Monitor Support

GoToMyPC supports multiple monitors connected to a single host
PC. You can choose which

monitor(s) to access while in session.

Connecting to a multi-monitor host PC

1. Log in and connect to your host PC. The default screen is
your primary monitor.

2. To select another monitor, click the arrow button located on
either sideof the viewer window; or click the + the left or right
arrow key on thekeyboard.

Note: For the + arrow keys function to work, "Pass Windows keys
to host computer" must beunchecked on the Preferences > Viewer
tab.

3. To view all host PC monitors, hold the key while selecting
Scale-To-Fit modefrom the View menu.

Connecting to a multi-monitor host PC with a multi-monitor
client computer

1. Log in and connect to your host PC.

2. Change to full screen mode to view both monitors by holding
the key and

clicking the maximize/minimize window button on the top right of
the Viewer; or hold the key and select Full Screen from the View
menu.

3. To toggle back to window mode, simply click the
maximize/minimize window button in

the viewer.

Note: Hardware limitations may prevent host PC screen blanking
from working with multiple monitors using a singlevideo card.

Note: Since GoToMyPC does not require the display monitors on
your host PC, you may want to turn them off before youleave to
conserve energy. You can also set your monitors to automatically
power down after a specified time in your PCsDisplay Properties
control panel.
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Minimap

The Minimap feature displays a scaled down version of your host
PCs monitor(s) and is usefulwhen you need to quickly navigate to a
different area on the host PC.

To navigate with the Minimap window

1. From the Viewer window, press and hold down the keys on
your

keyboard and then click the mouse button to display the Minimap
window.2. Click and drag the red box to navigate to another portion
of the host PC display.

3. Release the mouse button to close the Minimap window.
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Universal Viewer

The Universal Viewer enables you to view your host PC from any
computing device and operating

system that supports Java, including Mac, Linux and Solaris
computers or from Windowscomputers that do not accept downloadable
files.

This feature is particularly useful if you are using an Internet
kiosk. To help ensure the greatest

possible usability, the Universal Viewer has a limited set of
features and does not include supportfor Sound, Chat, Clipboard,
Remote Printing, File Transfer/Sync or Drag-and-Drop File
Transfer

or Viewer Dimming.

There is nothing you need to do to enable the Universal Viewer.
It will automatically appearduring the connection process if you
are using an operating system other than Windows to

connect to your host PC, or if you are using a Windows PC that
does not accept downloadablefiles.

To help ensure your security when using the Universal Viewer,
you are logged out of your

GoToMyPC session any time you navigate to a new Web page, exceed
your Viewer inactivitytime-out period without any keyboard or mouse
activity, or upon disconnection.

To begin a session with the Universal Viewer

1. Open a browser window and go towww.gotomypc.com.

2. Enter your email address and accountpasswordand click the Log
In b

3. If promp

utton.

ted, choose the account you

ts

C

us page, click

want to access and click Go (onlyapplies if you have multiple
accoun

associated with one email address).

4. To the right of the nickname of the Pto which you want to
connect, click

the Connect button.

5. On the connection statthe Use the Universal Viewer link.

6. The Universal Viewer should load inabout 30 seconds.

https://www.gotomypc.com/https://www.gotomypc.com/
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Universal View er Shortcut

The Shortcut feature adds a shortcut to the client computers
browsers Favorites or Bookmarksfolder. The Shortcut is convenient
for users who frequently use the same client computer to

access the same host PC (e.g. access a work PC from a home
computer). The shortcut saves

time by directing you to the Enter Access Code window, bypassing
the usual browser/passwordlogin page.

To create a shortcut from the Universal Viewer

1. Begin a session as described above.

2. From the Universal Viewer window, choose File, then Create
Shortcut to "Host PC Name."

3. Click Yes to authorize creation of a shortcut.

4. Select a location in your browsers Favorites folder and click
OK.

Note: If your browser does not support creating bookmarks
automatically, a link will be provided that can be pasted intoa
bookmark. Simply create a bookmark from your browser and then
right-click the new bookmark and select Properties.Replace the
existing bookmark link with the provided link.

Resize Your Host PC I mageYou can choose to change the size of
the image of your host PC desktop within the Universal

Viewer. You have the options of choosing to adjust your image
size to Actual Size, Scale to Fit orZoom To.

y Actual Size: Displays the actual image of the host PC desktop
within

the Universal Viewer and may require you to scroll.

y Scale to Fit: Displays the image of the host PC desktop scaled
to fitthe whole desktop image within the Universal Viewer.

y Zoom To: Allows you to zoom the image to a setting you
choose.You can choose from several pre-set options or choose a
custom

option. This selection may require you to scroll.

To resize your host PC image

y From the View menu, select View and then your preferred
image

size:

y Actual size

y Scale to fit

y Zoom to

Lock and Unlock your Host PC with Send Ctrl-A lt-Del

The Send Ctrl-Alt-Del feature can be used to unlock and lock a
host PC. For

more information please see the sections titled Remotely Unlock
Your Host PC

and Remotely Lock Your Host PC.


	
7/29/2019 Remote Control.pdf

27/96

GoToMyPC User Guide

2008 Citrix Online, LLC. All rights reserved. 16

GoToMyPC PocketView

PocketView

GoToMyPC PocketView enables you to securely access your host PC
from your compatible

handheld device. GoToMyPC PocketView includes support for use of
a stylus, scrolling, scaling,and portrait or landscape
orientation.

To help ensure the greatest possible usability, GoToMyPC
PocketView does not include Sound,

Chat, Remote Printing and File Transfer/Sync.

There is nothing you need to do to enable GoToMyPC PocketView.
It will be automatically

selected during the connection process if you are using a device
with a supported operatingsystem to connect to your host PC.

Note: To use GoToMyPC PocketView, see System Requirements at the
beginning of this guide. Please note thatperformance will depend on
the speed of the devices connection to the Internet.

Accessing Your Host PC Using PocketView

When accessing your host PC using a PocketView compatible
device, follow the same procedure

that is outlined for use with a desktop computer.

To remotely access your host PC

1. In your Web browser, enter www.gotomypc.com.

2. Enter your Emailaddress and account Passwordand click Log
In.

3. PocketView users will need to click the Download link to
begin the download. Select thecheckbox to open the file after
download. Overwrite the file if it already exists. Click Yes.

4. When prompted, enter the host PC's access code and click
OK.

5. The host PC image will appear in the PocketView window.

6. You are now connected to your host PC and are ready to start
accessing all your files,applications and email as if you were
sitting at your PC!

https://www.gotomypc.com/https://www.gotomypc.com/
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The PocketView Toolbar and Menu

The toolbar appears at the top of the handheld device and
enables you to quickly accesscommon PocketView features.

Show menu

Minimize

Right-click mode

Hover mode

On-screen keyboard(tap and hold tochoose the input

Show & hide

Move toolbarJump-navigate

The PocketView Menu

To display the menu, tap the Menu option on the PocketView
toolbar.

To adjust host PC image size

y From the View menu, use the Actual Size, Scale to Fit

or Zoom To settings

To adjust host PC image orientation

y From the View menu, use the No Rotation, Rotate Left

or Rotate Right settings

To access PocketView tools

y Use the Tools menu to access Send Ctrl-Alt-Del,Preferences and
PocketView Preferences
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The PocketView Preferences Dialog

In addition to the standard GoToMyPC Preferences, PocketView has
some per-device settings inits PocketView Preferences dialog. These
settings always take precedence over any settings in

the general GoToMyPC Preferences.

Initial size

y The initial size may be set to Actual Size or Scaleto Fit or
it can start in Jump-Navigate mode inwhich the first tap will zoom
to that point in Actual

Size.

Initial rotation

y The initial rotation may be set to No Rotation,

Rotate Left or Rotate Right.

Force 256 Colors (requires reconnect)

y Overrides host PC Color Quality preference set forTrue Color
for improved performance.

Large toolbar

y Increases the size of the toolbar

Auto-hide toolbar

y Hides the toolbar after each action
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Using PocketView

To quickly scroll to another area on your desktop

1. Tap the Jump-Navigation button on the toolbar to temporarily
put the Viewer into fit-to-screen mode so you can easily see your
entire desktop.

2. Click the part of the screen where you wish to scroll to and
you will be returned to your

previous zoom level, but centered at the location where you
clicked.

To scroll host PC image

y Tap and hold the stylus on the edge of the screen to scroll in
that direction. Scrolling willstop when the stylus is released.
When dragging a selection on the host PC, if you drag

the stylus to the edge of the screen, PocketView will
automatically begin scrolling so thatyou can select non-visible
areas of the host screen.

To right-click

1. Tap the right-click mode button and the next tap will be a
right-click.

2. Or you can use the tap-and-hold gesture to perform a
right-click (not all devices support

this).

To move the cursor without left-clicking

y Tap the hover mode button and the next tap will only move the
cursor.

To change the soft input panel

y Tap, hold and release the on-screen keyboard button to choose
an input panel.

To create a shortcut to your host PC

y Choose File from the PocketView menu, then CreateShortcut(not
all devices support this). The shortcut

will be added to your Programs folder.

To disconnect a PocketView session

y Choose File from the PocketView menu, thenDisconnect.

To restore PocketView (Pocket PC and Windows Mobile devices
only)

y To restore PocketView after minimizing it, choose Start, then
Programs and thenGoToMyPC PocketView.

Note: For more information about GoToMyPC features, refer to the
corresponding sections of the GoToMyPC User Guide.
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PocketView Usage Recommendations

Choose a device that is appropriate for you:

1. A Pocket PC, Windows Mobile, or Windows CE device with WiFi
provides the fastest

access.

2. A Pocket PC Phone Edition or Windows Mobile Phone Edition
device provides access over

the largest geographical area.3. An external or built-in
keyboard is recommended if you enter text often.

4. A Windows Mobile device with a high resolution (VGA) screen
is recommended for easiest

viewing.

Optimize your PocketView experience:

1. Right-click the GoToMyPC icon on your host computer and
select preferences. Under thehost tab, turn on the following
option:

y Automatically adjust the host computers screen area

2. From the View menu in PocketView:

y Set the Zoom to 75%

y Select Rotate Left or Rotate Right

3. From the File menu in PocketView:

y Create a shortcut to your host PC
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Using GoToMyPC Features

GoToMyPC is easy to use and comes with a complete set of
features to help you get the most out

of remotely accessing your PC. Outlined below are several of the
main features youll want totry. Most of the features are accessible
through the Viewer; other features are accessible from

the system tray icon, which is usually located in the
lower-right corner of your screen near

the clock. Some features are incompatible with some operating
systems. Please see the sectiontitled Feature Requirements at the
beginning of this document for more information.

Note: If you are a GoToMyPC Corporate user, your ability to
access features may be disabled by your administrator. Ifyou are
unable to access a feature, please contact your administrator for
further details.

Remote Printing

The Remote Printing feature enables you to print documents that
are on your host PC to your

local client computer printer. From your client computer, you
have the ability to print documentsfrom a host application that may
not be installed on the client computer.

There are two ways to set up a remote printer:

y The GoToMyPC Printer (recommended) is a quick and effective
method of printing files to

your client computers default printer. Simply select the
GoToMyPC Printer from the

Printer drop-down menu and print as you normally would. Please
see the section titledGoToMyPC Printer for details.

y Printing with the GoToMyPC Printer is recommended for most
jobs but there may besituations (e.g., printing checks or other
cases where precision is required) where you

will want to manually enable a specific printer. This process
requires that you first set upthe client computers printer type on
the host PC. Please see the section titled Manually

Enable a Printer for details.

Note: To simplify the remote-printer setup, we recommend that
you configure a printer while connected toyour host PC from a
client computer.
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GoToMyPC Printer

When you connect to your host PC, the GoToMyPC Printer feature
automatically detects the

printers available to your client computer. By selecting the
GoToMyPC Printer from the Printwindow, you are directing the print
job to your client computers default printer.

To print from the client computer

1. Open your file and select Printfrom your applications File
menu.2. Verify that the GoToMyPC Printeris selected in the Printer
drop-down menu.

3. Click OK to print to your client computers default
printer.

To change the local printer that the GoToMyPC Printer will to
print to

1. From the Viewer window menu, select File, then Select
GoToMyPC Printer.

2. Select the local printer that you want the GoToMyPC Printer
to print to.

3. Return to the client application and print the document by
selecting the GoToMyPCPrinter.
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Manually Enable a Printer

If you wish to manually enable a printer and bypass the GoToMyPC
Printer, you will be required

to first set up the client computers printer type on the host
PC.

Some printers require a host PC reboot upon setup. This requires
the GoToMyPC startup

preference to be set to start automatically: Right-click the
icon in the system tray of your

host PC and select Preferences, then Host. Under Start GoToMyPC,
check "Automatically" andselect "After startup."

Note: The add printer wizard will not be able to detect the type
of printer if you attempt to install the printer from thesystem
tray icon while you are not in session. The process of installing
Remote Printing will vary depending uponoperating system and access
to printer drivers. If you do not have the necessary printer driver
on your host PC, you mayneed to download the driver from the
manufacturers Web site before you can complete the installation of
a remoteprinter.

To manually install a printer to the client computer while
remotely connected

1. From the Viewer window, right-click the icon in the system
tray and selectPreferences.

2. On the Preferences menu, select the Printing tab.

3. Click the Add Printer button.

4. On the Select a Printerto Set Up screen, the drop-down menu
will automatically selectthe default printer (from your Printers
folder) installed on your local client computer. If

you wish to select another printer, click the drop-down menu and
choose the printer youwant to set up.

5. Click OK.

6. TheAdd Printer Wizardscreen opens. Notice the GoToMyPC
Printer Setup InstructionsTips window attached to the left of
theAdd Printer Wizardscreen. Please pay particularly

attention to this menu during the setup process; it will provide
assistance in setting up a

GoToMyPC printer. Click Next.

7. On the Localor Network Printerscreen, select Local printer.
Make sure that Plug and Play

auto-detection is NOT selected. Click Next.

8. On the Select the Printer Portscreen, scroll down and select
the GoToPort. Click Next.9. On the Install Printer Software screen,
select the manufacturer and model of your

printer. Click Next.

Note: Start by selecting the manufacturer and then select the
printer model that is closest to the model youhave. If you cannot
find a match, you may need to download the driver from the
manufacturers Web site.Once you have downloaded the driver (be sure
it is the correct driver for your host PC operating system),
clickthe Have Disk button, browse to where you downloaded the
driver, select the driver and click OK.

10.On the Name your printerscreen, enter the name for this
printer. We recommend that

you keep the "GoToMyPC" preface to the printer name to help you
identify the printer inthe future. Select No if asked to set this
printer as the default printer. Click Next.

11.On the Printer Sharing screen, select Do not share this
printer. Click Next.

12.On the Print Testscreen, select Yes if you are remotely
connected; select No if not. Click

Next.

13.Click Finish.

Note: If your host PC operating system is Windows 2000, XP or
Vista and you wish to manually enable a printer, pleaseensure that
you have administrator rights when you upgrade/install
GoToMyPC.
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File Transfer

File Transfer enables you to quickly and easily transfer files
between your host PC and client

computer. You can use the File Transfer feature or you can drag
and drop files simply by clicking

on a file and dragging it between computers.

To transfer files

1. From the Viewer menu, chooseTools, then Transfer or
SyncFiles. Or you can click the File

Transfer button in the upperright-hand corner of the Viewer

window.

The File Transfer and Sync

window opens. The host PC filesare in the left pane, the
client

computer files on the right.

2. For the computer you wish to

transfer files to, browse to and

select the folder to store thetransferred files.

3. For the computer you wish totransfer files from, browse
to

and select the file or folder you wish to transfer and either
click the Transfer button ordrag-and-drop the desired files to the
destination computer.

4. Click Done from the File Transfer status window when
complete.

To drag and drop files

y To drag and drop files directly between your host and client
simply drag a file or folder

from the Viewer window to your local computer (or the other way
around) to startcopying.

Note: If you are having difficulty finding the files to send, or
finding the files you sent, it is l ikely due to the use of a
userprofile, which most often occurs with Windows 2000. To transfer
desktop files stored in your profile or to find files
youtransferred to your desktop, you will need to look for the
appropriate folder within your user profile. Windows 2000users: go
to C: Documents and Settings, then Your User Name, then
Desktop.

Note: If you are having difficulty transferring files from
Windows Vista, it could be that you are attempting to transferfiles
from a folder that requires privilege elevation. To transfer these
files, first transfer them to a folder you have

permission to write to, and then move them to their final
destination using Windows Explorer.
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File Sync

The File Sync feature enables you to easily synchronize folder
contents between the host PC andclient computer while in-session.
Since File Sync is bi-directional, files are transferred in
either

direction until both sides match. When files with the same name
exist on both ends, you have

the option to copy the newer file, copy the older file or skip
the file.

To synchronize folders1. From the Viewer menu, choose Tools,
then Transfer or Sync

Files. Or you can click the File Transfer button in the
upper

right-hand corner of the Viewer window.

The File Transfer and Syncwindow opens. The host PC files

are in the left pane, the client computer files on the
right.

2. Double-click the folder you want to sync on the host PC
so

that the contents are displayed in the left pane.

3. Next, double-click the corresponding folder you want to sync
on the client computer so

that the contents are displayed in the right pane.

4. Click the Sync Views button from the File Transfer and
Syncwindow.

5. From the Sync Confirmation window, indicate how you prefer
GoToMyPC to handle

different files with the same name.

6. Click Continue to begin synchronization.
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Repeat a Recent File Sync

Select the Repeat a Recent File Syncshortcut to save the step of
navigating to the individualfolders on your host PC and client
computer. This feature displays a selectable list of the last

three syncs for quick execution.

To repeat a recent file sync

1. From the Viewer menu, choose Tools and then Repeat a Recent
File Sync.

2. Select a folder pair from one of the three most recent file
syncs.

3. Confirm the folder locations and indicate how you prefer
GoToMyPC to handle different

files with the same name.

4. Click Continue to begin synchronization.
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Remote Sound

GoToMyPC now supports one-way sound from your host PC to your
client computer. The soundsettings can be optimized for system
sounds or music depending on your sound card, personal

preferences and the speed of your network connection. Temporary
adjustments to your in-

session sound settings can be made directly from the Viewer
window. Adjustments to your soundsettings can be made at any time
in the Preferences window or directly from the Sound button

in the upper right-hand corner of the Viewer window.

To modify your sound preferences

1. Click the Sound button in the upper right-hand corner of the
Viewer window.

2. Select Sound Settings from the menu.

3. From the Soundtab modify your sound settings and click
OK.

Sound Features

y When my session starts: Select

your preferred sound settings onstartup. Select the Turn off
Sound

option for optimal system

performance. If you intend to listen tomusic, select Use High
Quality Sound.

y Sound options: Select your

preferred audio source or letGoToMyPC detect the source

automatically. If desired, GoToMyPCcan automatically disable the
Sound

feature if a slow network connection

is detected. For in-session privacy,

leave the "Mute speakers on the hostPC while in session" option
selected.

The Manualoption on the Sound Options drop-down list is not
recommended for typical use.When selected, GoToMyPC records sound
from the Windows default recording device without

changing the active input or volume level. If these inputs are
not configured correctly the soundmay not work or have poor
quality.

Please see the Troubleshooting Sound Issues section for more
information on the Sound feature.

Note: If you are listening to music from your host PC, be sure
to stop the music before disconnecting your session. Ifyou do not
stop the music on the host PC before disconnection, the music will
no longer be muted and could be heard byanyone close to your host
PC.

Note: For optimal music quality, install the latest approved
Windows Media Player on both the host PC and clientcomputer.

Note: The High Quality Sound option is currently not available
on Windows Vista. Sound is not available with theUniversal Viewer
or PocketView.

Note: GoToMyPC software may be used to access materials on a
remote computer. It is licensed to you only for accessto remote
computers which you are authorized to access or make use of, and
for access to non-copyrighted materials,materials in which you own
the copyright, or materials you are authorized or legally permitted
to access. If you areuncertain about your right to access any
material you should contact your legal advisor.
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Session Performance

While remotely connected to your PC, you can review your session
performance and tips forimproving the performance.

Note: GoToMyPC will automatically disable Vistas Aero Glass
Windows theme to maintain optimal performance.

To view your session performance

1. In the GoToMyPC Viewer window, click Help in the top
menu.

2. Select Session Performance.

3. Your session performance will be displayed for the host PC to
which you are currentlyconnected.

Select toviewperformance

of last 10minutes orclick drop-

down menuto viewperformanceof any of

previous 10sessions.

The performancegraph belowchanges as youmove yourcursor over
the

blue bar to

reflectperformance ofyour host PC,client computer,and
internet.

Click here toviewperformanceimprovementsuggestions.

Shows timedelay over thelast 10 minutes.
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Guest I nvite

The Guest Invite feature enables you to invite a guest to view
the desktop of your host PC whileyou are physically present at your
host PC.

To invite a guest to your host PC

1. Right-click the system tray icon and select

Invite Guest to PC.

2. When prompted, type in the email address of the guest you

want to invite. Or you can select an email from a list
ofrecently invited guests by clicking the drop-down menu.

3. Add to or customize the message that will be sent to your

guest (optional).

4. From the drop-down menu, select the time when the
invitation

will expire.

5. Click Send.

6. When prompted, enter the email address and password you use
to log in to GoToMyPC.

7. Click OK.

8. Your invitation is sent to your guest, who will receive it
via email. Click OK to close the

send notification.

Note: You must be at your host PC to invite a guest to connect
to it. After you send an invitation, you can check thetime left on
the invitation or cancel it by right-clicking the system tray icon
and selecting Guest Invited. You can inviteguests on any operating
system and GoToMyPC will provide the appropriate Viewer window.
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Connect to an Invited Guest

To accept the invitation, your guest will need to click the
activation link included in the invitationemail. If your guest
accepts within the time you allotted, you receive a Guest Arrived
notice.

To connect with the guest on your host PC

1. In the Guest Arrivedwindow, select the

corresponding check box to give your guestview-only access or
full remote-control

access to your computer.

2. Uncheck the Sound box if you do not wantyour guest to hear
the sound on your PC.

3. Click OK.

A chat box will appear on your desktop and

your guest will be able to view your desktop

with a Viewer window on his or her desktop.

Change Guest Access

You may change your guests access or disconnect the session at
any time.

To modify guest access from your host PC

1. Right-click the system tray icon and select Guest
Connected.

2. Select the desired level of access or disconnect the
session.
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Chat

Chat is a function that enables you to communicate with a guest
you have invited to your

computer. To communicate with Chat, simply enter your text into
the text entry field and clickSend or press the key on your
keyboard. The chat dialog is automatically displayed

once your guest is connected.

To open a Chat dialog

y From the Viewer window menu, select Tools, then Chat.

The chat box will appear on both the host PC and client
computer.

To end Chat

y From both the host and client chat box, simply close the

box by clicking in the upper-right corner of the chat

dialog.
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Drawing Tools in Guest Session

The Drawing Tools feature enables you and your guest to use a
mouse to draw or highlight on

the screen for greater communication.

Note: The Drawing Tools feature is only accessible while
connected to a guest.

To use a drawing tool

1. To access the drawings tools from the guests Viewer window,
choose Tools, thenDrawing Tools. Or the guest can click the Drawing
Tools button in the upper right-hand

corner of the Viewer window.

To access the drawing tools from the host PC, right-click the
icon in the system tray

and select Drawing Tools.

2. Select the desired tool and click and drag to draw on the
screen.

To erase drawings

y With one of the drawing tools enabled, right-click the screen
and select

Erase All Drawings.

This will erase your drawings but keep you in the drawing
mode.

To exit the drawing mode

y Press the key or right-click the screen and select Mouse
Pointer

from the Drawing Tools menu to exit the drawing mode.
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Cut/ Copy and Paste

The cut/copy and paste feature enables you to cut/copy and paste
text between the host PC andclient computer.

To cut/copy and paste text

1. Select the text you want to cut or copy by left-clicking you
mouse and dragging the

cursor over the text.2. Right-click your mouse on the selected
text and choose Cutor Copy.

3. Place your mouse in the location where you want to paste the
text and left-click your

mouse.

4. Right-click your mouse and select Paste.

Note: The cut/copy and paste feature has a text-only maximum of
32kb of data.
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Desktop Shortcut

The Desktop Shortcut feature adds a shortcut to the client
computer desktop that links directlyto your host PC to enable fast
and easy access to the PC. Desktop Shortcut is convenient for

users who frequently use the same client computer to access the
same host PC (e.g. access a

work PC from a home computer). The shortcut saves time by
directing you to the Enter AccessCode window, bypassing the usual
browser/password login page.

To create a desktop shortcut

1. Log in and remotely connect to your host PC from the

client computer on which you want to create thedesktop
shortcut.

2. From the client computer Viewer window, choose File,

then Create Shortcut to "Host PC Name".

3. Click Yes to authorize creation of a desktop shortcut.

4. Enter your account password and click Continue.

5. Click OK.

A desktop shortcut will be created on your client computer
desktop.

Note: The first time you use a shortcut from a client computer,
you will be required to authenticate your account byentering your
email address and password. If this first-time log in is
successful, subsequent uses of Desktop Shortcut onthe client
computer will not require authentication. The Create Shortcut menu
item on the File menu will not be visiblewhen a guest is connected
to your PC during a Guest Invite session so that guests cannot
create shortcuts from theircomputers to yours. You can revoke all
shortcuts associated with your host PC by clicking the Edit link on
the MyComputers page.

To access your host PC using a desktop shortcut

1. From the desktop of the client computer, double-click the
GoToMyPC

Desktop Shortcut icon.

2. When prompted, enter the access code for your host PC.

The GoToMyPC connection will begin.

To revoke all desktop shortcuts to your host PC

1. Log in to your GoToMyPC My Computers page.

2. On the My Computers page, click Edit next to the name of the
PC for which you wish to

revoke all desktop shortcuts.

3. Next click the Revoke button; this will invalidate all
shortcuts to your host PC.

Note: If you are a GoToMyPC Corporate account user, your ability
to access features may be disabled by your GoToMyPCaccount
administrator. If you are unable to access a feature, please
contact your account administrator for furtherdetails.

Reconnect

GoToMyPC warns you if a session is about to bedisconnected due
to inactivity. If prompted, simply click

Keep Active to keep the session active; otherwise, clickthe
Disconnect Now button to end the session.

If your session is timed-out, you are given an option to

begin a new session by clicking Reconnect from theInactivity
window. If you used the Shortcut feature to

begin the session, you are quickly directed to the Enter Access
Code window.
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Remember Me

The Remember Me feature enables you to set a cookie in your
browser that will automatically log

you in to a specific GoToMyPC account - without the need for you
to enter your email and

password simply by returning to the GoToMyPC Web site.

To enable Remember Me

1. From the client computer on which you want to activate the
Remember Me feature - login to your GoToMyPC account.

2. Click the My Accountlink in the left navigation bar.

3. Select the check box for Remember Me.

4. Enter your current password to make changes.

5. Click Save Changes.

Note: Use of the Remember Me feature requires that cookies be
enabled for your browser (please see your browsersHelp for
directions on how to enable cookies). To use the Remember Me
feature, you must close your browser by clicking

the button in the upper-right corner of the browser window, or
by choosing File then selecting Close from the menu.The Remember Me
feature will NOT work if you click the Log Out link in the left
navigation bar.

To disable Remember Me

1. From the client computer on which you want to activate the
Remember Me feature, login to your GoToMyPC account.

2. Click the My Accountlink in the left navigation bar.

3. Uncheck the Remember Me check box to clear.

4. Enter your current password to make changes.5. Click Save
Changes.
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I n-Session Reboot (GoToMyPC Corporate only)

The In-Session Reboot feature enables you to remotely reboot
your host PC and log back in with

your Windows login credentials. This is an exclusive feature to
accounts that have the SharedAccess feature enabled. Since the
In-Session Reboot feature is not a default setting, it must
first

be enabled by your administrator at the user or group level in
the GoToMyPC AdministrationCenter.

View Access Activity Report

The Access Activity Report enables you to view your accounts
connections for a selected day.The report will tell you the source
of the connection, the time it occurred, the client IP, the typeof
access and the duration of the connection.

To view the Access Activity Report

1. Log in to your GoToMyPC account at www.gotomypc.com.

2. Click the My Computers link in the left menu.

3. Click theAccess Activitylink in the left menu.

4. Select the desired date for the access activity.

5. Click the View Access Activity button.

https://www.gotomypc.com/https://www.gotomypc.com/
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One-Time Passwords

The use of One-Time Passwords (OTPs) offers an additional level
of security that can protect youwhile you are using public
terminals that may have keyboard loggers or other
keystroke-capture

hardware or software. Our One-Time Passwords system ensures that
a discovered password is

useless to the person who discovers it.

One-Time Passwords are composed of six words, and each six-word
combination provides one-time access to a host PC. Password lists
are numbered in reverse order from highest to lowestand end in
zero.

The use of One-Time Passwords enables you to generate a list of
One-Time Passwords that youwill be prompted to enter after you
enter your access code each time you access your host PC.

Note: Your administrator may require that you use One-Time
Passwords. The One-Time Passwords feature cannot beused in
conjunction with the Share Access feature.

To enable One-Time Passwords

1. While physically present at the host PC you want to enable
for One-Time Passwords,

right-click the system tray icon and choose Preferences.

2. Click theAuthentication tab, then click the Enable OTPs
button.

3. On the Generate One-Time Passwords dialog box, select the
number of One-TimePasswords to generate (min. of 10, max. of 99)
and click OK.

4. On the Enter Access Code box, enter the access code for the
host PC and click OK.

5. On the Print One-Time Passwords Listdialog box, select the
font size to print and clickthe Print button.

6. Verify your list of One-Time

Passwords has printed andclick Close.

7. On the GoToMyPC

Preferences dialog box,click OK.

You have now enabled useof One-Time Passwords on

your host PC and you will beprompted to enter an OTP

next time you access yourhost PC from a client

computer.
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To access your host PC using One-Time Passwords

1. Point your Web browser to www.gotomypc.com.

2. Enter your email address and account password and click Log
In.

3. If prompted, choose the account you want to access and click
Go (only applies if you

have multiple accounts associated with one email address).

This will load your My Computers page.

4. To the right of the computer Nickname, click the Connect
button.

5. When prompted, click Yes or Grant to download the GoToMyPC
Viewer.

6. When prompted, enter the host PC's access code and click
OK.

7. When prompted, enter the requested six-word One-Time
Passwords and click OK.

8. The host PC image will appear in the Viewer window.

You are now connected to your host PC and are ready to begin
accessing all your files,applications and email as if you were
sitting at your PC!

To generate a new list of One-Time Passwords

1. While physically present at, or connected to, the host PC for
which you want to generatea new list of One-Time Passwords,
right-click the system tray icon and choose

Generate One-Time Passwords.

2. On the Generate One-Time Passwords dialog box, select the
number of One-TimePasswords to generate (min. of 10, max. of 99)
and click OK.

3. On the Enter Access Code dialog box, enter the access code
for the host PC and click OK.

4. On the Print One-Time Passwords Listdialog box, select the
font size to print and clickthe Print button.

5. Verify that your list of One-Time Passwords has been printed
and click Close.

Note: You can generate a new list of One-Time Passwords at any
time while still have OTPs available. Should you use allyour OTPs
before generating a new list, you will have to return to your host
PC to generate a new list or to disable One-Time Passwords.

To disable One-Time Passwords

1. While at the host PC for which you want to disable One-Time
Passwords, right-click the

system tray icon and choose Preferences.

2. Click theAuthentication tab.

3. Click the Disable OTPs button.

4. Click Yes on the warning dialog box that you want to disable
One-Time Passwords.

5. On the Change Access Code dialog box:

y Enter your old access code.

y Enter your new access code.

y Confirm your new access code.y Click OK.

6. On the GoToMyPC Preferences dialog box click OK.

Note: To help protect your security, you will be required to
change your access code for your host PC anytime youdisable the use
of One-Time Passwords.

https://www.gotomypc.com/https://www.gotomypc.com/
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